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1 Introduction to SimApis

A SimApi is a software interface between the Umetrics Suite software and a data source. The primary
purpose of a SimApi is to provide data to SIMCA®-online or SIMCA®,

Sartorius Stedim Data Analytics AB develops SimApis for many different data sources, such as process historians and
general-purpose databases.

This document shows what a SimApi is, and how it is used in Umetrics Suite products. You'll learn how to plan for,
and install a SimApi, how to troubleshoot and how to test your installation. The final chapter is about technical
details of SimApis aimed at developers.
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. [ BShort_G2
Suite products
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of SIMCA-online but can be a process historian or other system that keeps and manages the data.

A SimApi exposes a hierarchy of nodes, corresponding to folders in a file system. Each node can contain other
nodes, or tags. A tag corresponds to a variable. For these tags Umetrics Suite products can obtain data. The picture
shows a tag, Temp, selected in the node BakersYeastControlGood in a data source in SIMCA-online.

1.2 SimApi usage in the Umetrics Suite

SIMCA can use a SimApi to retrieve data for project creation and model building as the following picture illustrates.
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Figure 1. SIMCA used to obtain data from a data source through a SimApi.

SimApi Guide | Ensure Manufacturing Success



Introduction to SimApis

SIMCA-online uses SimApis to obtain data in real-time for monitoring and control, as well as write back of data to
the data source. The following picture shows where the SimApi is in a system consisting of a data source, SIMCA-
online server, and clients.

Data sources SIMCA®-online server Clients

77777 P rocess {:E} RPC ;E
Project

Batches configurations Desktop
Process historian [ SimApis
MES
LMs Atline | E @ HTTPS

DCS/SCADA/PLC SIMCA® projects Web
Firewall Firewall

S

Storage

v

Active Directory Notifications

Figure 2. ASIMCA-online installation with a server with SimApis connecting to data sources, and SIMCA-online clients working with data
on the SIMCA-online server.

1.3 Commonly used SimApis

The most widely used SimApis are:

e The SimApis for connecting to OSlsoft PI:
o the Pl AF SimApi developed by Sartorius Stedim Data Analytics
o the old Pl Batch SimApi developed by OSlsoft
e The ODBC SimApi - for general access to databases such as SQL Server or Oracle

The full list of available SimApis are listed together with their features in paragraph 3. We recommend that
customers use one of these tried and tested SimApis that provides full functionality with SIMCA-online or SIMCA.

1.4 The DBMaker SimApi for simulation data

DBMaker is an application provided with the SIMCA-online server installation. It simulates a data source, such as a
process historian, by using a preloaded data table with several observations which are provided one by one to
SIMCA-online through the DBMaker SimApi.

DBMaker is only used for demonstration purposes and cannot be used in production with live data from a data
source'.

See the built-in help to learn more about DBMaker.

"You can publish your own data with DBMaker for testing SIMCA-online or demoing it with your own data. See the
following knowledgebase article for more information: umetrics.com/kb/testing-simca-online-real-world-data-

without-simapi
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1.5 Additional documentation

The document you are reading now is one of a set of related documents, each with different focus and target
audience:

Source What Where

SIMCA-online web Introductory information and downloads sartorius.com/umetrics-simca-online
page

SIMCA-online Installation and how to get started with SIMCA- In the installation zip file

ReadMe and online demo data

Installation.pdf

SIMCA-online Outlines SIMCA-online functionality, puts it in sartorius.com/umetrics-simca-online
Implementation context with other Umetrics Suite software,
Guide describes requirements and best practices for

successful deployment, and step-by-step
installation instructions.

SimApi Guide Preparing for and performing SimApi installations,  sartorius.com/umetrics-simapi
including troubleshooting. Also contains technical
details on SimApis for developers.

SimApi User Guides  One for each published SimApi. Lists the features,  sartorius.com/umetrics-simapi
installation instructions, and configuration
specifics of each individual SimApi.

SIMCA-online Technical reference for SIMCA-online server sartorius.com/umetrics-simca-online
Technical Guide installation planning, troubleshooting, and in-
depth how SIMCA-online works.

SIMCA-online help How to use SIMCA-online and how SIMCA-online  In the software itself, and on

works. sartorius.com/umetrics-simca-online
SIMCA-online Web  Describes the installation of the SIMCA-online sartorius.com/umetrics-simca-online
Client Installation Web Client.
Guide
Umetrics Searchable database with articles about each sartorius.com/umetrics-kb
knowledge base released software version, technical articles, and

known issues on Umetrics Suite products.
SIMCA help / user How to use SIMCA for creating projects. In SIMCA and on
guide sartorius.com/umetrics-simca

1.6 Technical support
Sartorius online support team answers technical questions about SimApis and can also forward requests for
enhancement of SimApis to the appropriate people. Learn more at sartorius.com/umetrics-support.

2 Obtaining SimApis

We provide documentation for SimApis, and links to SimApis which are offered from partners, at
sartorius.com/umetrics-simapi.

All SimApis built in-house can be acquired for free in the web shop on that page.

Consult the feature matrix to learn more about SimApi functionality and which SimApi that supports which feature.
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SimApi features

For details about a specific SimApi, see its User Guide. The individual SimApi user guide and this document have

complementing information when it comes to SimApi planning, installation, and troubleshooting.

3 SimApi features

Not all data sources are alike. A SimApi need not implement all functions in the specification. For these reasons,
different SimApis offer different functionality. The following matrix lists available SimApis and their features.

&
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continuous data
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Connection
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The below table explains each feature. Notice that the table has separate columns to show which features are
available in SIMCA-online and SIMCA respectively.

Feature

Purpose

SIMCA-online usage

SIMCA usage

Current data

Read the most recent value
from the data source.

Real-time normal execution

Historical data

Read historical data from the
data source.

Catch-up and predict of past
data, create projects using
File > New

Database Import
Wizard to import
process data for
model creation.

Discrete data

Read laboratory/IPC data from
the data source. Discrete data
can be used for batch
configurations when data needs
to be re-read during the batch
evolution. Many observations
per batch.

For batch projects with
phases configured for
discrete data retrieval.
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Feature Purpose SIMCA-online usage SIMCA usage
Batch data Read batch conditions and final ~ Batch conditions or local Database Import
quality attributes (or other MES  centering. Wizard to read batch
type data). One observation per conditions for batch
batch. level model creation.
Batch node Specify the start time and the Required for execution of Database Import
end time (empty for an active batch configurations. Wizard to select
batch) for a specific batch. batches to import.
Enumerate all batches that
existed in a time range.
Write back - Write continuous data, suchas ~ Write back for batch
continuous predictions, back to the data configurations for the batch
data source. evolution level or for
continuous configurations
Write back - Write discrete data, such as Write back for batch
discrete predictions, back to the data configurations at the batch
source. evolution level for phases
configured for discrete data
retrieval
Write back - Write back batch level data, Write back for batch
batch data such as predictions or final configuration at the batch

quality attributes, to the data
source.

level

Node hierarchy

The SimApi supports a
hierarchy of nodes, similarly to a
file system. Each node can
contain tags and other nodes.
The hierarchy makes is easier to
manage a large number of
nodes and tags.

Supported in all places where
tags are used.

Array tag An array tag stores multiple Supported where tags are
expansion values. The SimApi expands the  used for continuous data.

array tag to many individual

tags, one for each value in the

array.
Multiple data The SimApi can connect to Connect to several different
sources more than a single data source data sources of the same

or supports multiple instances kind. See

of itself with individual settings umetrics.com/kb/multiple-

and log files for each instance. instances-same-simapi-

simca-online-server

Connection If the SimApi becomes The SIMCA-online server
resiliency disconnected from the data doesn't have to be restarted

source, it will try to reestablish
the connection.

SimApi Guide | Ensure Manufacturing Success
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Preparing for a SimApi installation

Feature Purpose SIMCA-online usage SIMCA usage
Developed in- The SimApi is developed,
house provided and supported by

Sartorius Stedim Data Analytics

AB.

3.1 Only current data, without historical data, is not recommended
Some SimApis, notably OPC DA, only supports reading current data, and not historical data.

A SimApi that only supports current data cannot be used in SIMCA, because it won’t be able to read historical data
on which to build the models.

For SIMCA-online, we strongly recommend a data source and SimApi that provide not only current data for real-
time execution, but also historical data to be able to predict and catch-up past data. SIMCA-online automatically
switches between real-time data and historical data as needed.

A data source that only provides current data but not historical data can work for continuous projects in SIMCA-
online, but for batch projects historical data is required.

4 Preparing fora SimApi installation

This section describes important information for a successful installation of a SimApi.

41 32-or 64-bit SimApis

There are 32-bit and 64-bit versions of each SimApi. Which one to use depends on the architecture of the program
you want to use it with. For example, a 64-bit SIMCA-online server requires a 64-bit SimApi DLL, and a 32-bit SIMCA
desktop software requires a 32-bit SimApi DLL.

4.2 Location forlog file and settings
A SimApi stores its log files in the hidden Program Data folder*

%programdata%\Umetrics\SimApi, where %programdata% maps to the actual folder on your computer. It defaults
to C:\ProgramData.

Each SimApi typically uses its own log file, which similarly to the SIMCA-online server log file will contain more or less
data depending on a log level setting. This file is useful for troubleshooting. The log file is named <simapi>.log where
<simapi> is the SimApi that you are installing, for example PIAFSimApi. Also see the next section for SIMCA-online
SimApi instance names.

This folder also contains the SimApi settings in an XML file named <simapi>.xml.

Most SimApis have graphical user interfaces that change the settings in the xml file, but for some you enter the
changes directly in the XML file with a text editor, such as Notepad. See the user guide for each SimApi for more
information.

4.3 File names when named instances are used with SIMCA-online

With SIMCA-online 13.1 or later, each SimApi instance get its own configuration file and log file in order to support
multiple instances of each SimApi. The names of these files are suffixed by the name of the instance as given on the
SimApi tab in the SIMCA-online Server Options dialog. The following example shows the naming of these files,
where <simapi> needs to be replaced with the SimApi name.

Configuration name given when the instance is added: OmegaServer

Configuration file name: <simapi>OmegaServer.xml

2This folder is hidden in Windows by default. In order to see it in Windows Explorer you configure File Explorer to
show hidden files. Note that you can navigate to a hidden folder by copying and pasting the folder path to File
Explorer’s address bar.
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Log file name: <simapi>OmegaServer.log

Note that the generic file <simapi>.log file is still created. This log file contains entries that for technical reasons
cannot be directed to the log file of the instances.

Note that SIMCA does not support multiple instances of the SimApi, and therefore uses the names without instance
name as described above.

4.4 Network planning
You should locate the SIMCA-online server close to the data source in the network. This ensures a fast connection
between SIMCA-online and its data source.

Networking equipment may interfere with the connection between SIMCA-online and the data source; firewalls can
for example drop connections after a period of inactivity resulting in problems in SIMCA-online where the data
source becomes disconnected in a SimApi.

4.5 Useraccounts and data source permissions
Data sources typically control access to their data. This is usually done with usernames and passwords but |P-
address- or DNS-based restrictions can also be used (for example Pl Trusts in OSlsoft PI).

The username and password can be provided to the data source in different ways:

e ASimApiisrun as the Windows user of the user running SIMCA or the SIMCA-online service account on
the server computer. The SimApi can connect to the data source using this account. This is how the OPC
HDA, and the OSlsoft PI SimAPi work, and ODBC if you don’t provide credentials when configurating it.

e Forgeneric ODBC you can use the ODBC Data Sources Administrator application found on Start in
Windows.

e Some database providers provide their own drivers and tools for their databases. Oracle databases, for
example, use the Oracle Data Access Components (ODAC).

e Some SimApis, such as PI AF and ODBC, have configuration dialogs that store the encrypted credentials in
the SimApi XML configuration file.

e OPCDAand HDA use DCOM as the transport between data source and SimApi. DCOM is configured with
the Component Services tool (DCOMCNFG.EXE) in Windows and uses Windows authentication.

e Forthe OSlsoft Pl SimApi (not the newer AF SimApi), the OSIsoft AboutPI-SDK application
(PISDKUtility.exe) is used to set up the connection to the Pl server.

e Plalso hasvarious security options available in the Pl System Management Tools on the Pl server computer.
Read more in the Pl AF SimApi User Guide. This guide is helpful even if you use the older OSlsoft Pl SimApi.

4.6 Verifying data source connectivity
When you want to install a SimApi on a computer it can be useful to verify the connectivity from that computer to
the data source with another tool:

e  Matrikon OPC Explorer for DA or HDA (these are separate tools) can be used to test OPC connectivity, and
Matrikon OPC Analyzer can be used to diagnose the OPC connectivity issues. Download these free tools
from https://www.matrikonopc.com/products/opc-desktop-tools/index.aspx

e OPC Rescue (for DA and HDA) from the OPC Training Institute’s web site “enables users to easily diagnose
communication and security problems, and repair them instantly with the push of a button. All this can be
done without ever having to learn to configure DCOM”

o ODBC Data Sources in Windows is used to configure and test generic ODBC. Note that there are two
versions of this tool on 64-bit Windows: one for 32-bit applications and one for 64-bit3. Use the Test Data
Source button at the end of the ODBC configuration wizard to verify connectivity to the database. We
recommend that you configure your data sources as System DSNs.

3 |n Windows, use Start search to find both the 32- and 64-bit ODBC Data Sources tools. In 64-bit Windows 7 the
start menu only lists the 64-bit version, but you can start the 32-bit ODBC Data Sources program by launching it
manually from the SysWowé4-folder, typically C:\Windows\SysWOWé4.
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A database specific connection tool from the provider of the database, such as the Oracle Data Access
Components.

Pl System Explorer can be used to test connectivity to the Pl AF server. It is part of the Pl AF Client which is
a pre-requisite for the Pl AF SimApi.

AboutPI-SDK application (PISDKUtility.exe) can be used to test connectivity and to view any error
messages that might have been logged when SIMCA-online tries to connect to the Pl server. This is only
used for the older OSlsoft SimApi, not PIAF.

Pl System Management Tools are used on the Pl server computer for troubleshooting from that side. For
example, to look for security issues preventing access from the SIMCA-online server. Learn more on PI
system troubleshooting in this YouTube video.

Excel can be used to obtain data from an ODBC connection and most other systems when a suitable plugin
is installed.

5 Installing a SImApi

Here is how to install a SimApi on a computer:

1.

2.

o

5.1

Read the User Guide for the SimApi you are installing. It contains specifics for that SimApi that complement
the general instructions you are reading now.

Install and configure any prerequisites mentioned in the SimApi User Guide (for example database drivers
or SDKs)

Run the setup program to install the SimApi. Install the 64-bit (x64) or the 32-bit (x86) version that matches
the software you will run it in.

Configure the SimApi in SIMCA-online or SIMCA as described in the following sections and refer to the
user guide of the SimApi for descriptions of available settings.

Start the SIMCA-online server. Note that this can take time, because when the SimApi is initialized, it will
enumerate all tags in the data source.

Test the SimApi by obtaining some data. For SIMCA-online, you can use File > Extract as described in 6.1.

If the SimApi fails to work as expected, refer to the SimApi log files to help troubleshooting, and to the
SimApi user guide.

Setting up the SimApi for use in SIMCA

Here’s how to use the SimApiin SIMCA:

1.

Start the database import in one of the following ways:
a. InSIMCA: File > New Regular Project or New Batch Project. If the database import wizard is not
opened automatically, open it from File > New Spreadsheet > From Database.
b. InSIMCA: Import Dataset on the Data tab of an open SIMCA project.
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2. Click Add new data source

w

No ok

L X
Paths and directories  SMAPI Miscellaneous
| ASimApi connects the server to a data source. Only selected SimApis will be loaded when the server is started.
Name Path
DBMaker C:\Program Files\Umetrics\SIMCA-online 15. 1\SIMCAonlinedbmakersimapi2. dil
Add SimApi ps [

| Give the new SimApi instance an unigue name, and use the ... button to Batch

| browse to the SimApi DLL file,

; MName:

MyPIServar\
Path:
C:\Program Files\Umetrics\SimApi\PIAFSimApIPIAFSImAp. | ..
Cancel
Add... Remove Configure. ..
0K Cancel Help
< Back Next > Cancel Help

B ' Add New Data Source X

Connection type:

SimApi i

Configure... Test data source... OK Cancel

Select SimApi as the connection type, click the ...-button and locate the <simapi>.dll in the installation
folder, and click Open.

Click Configure and refer to the individual SimApi User Guide how to make the settings.

Click the Test data source connection to verify that you can connect to the database.

Click OK to complete the configuration.

Refer to the SIMCA help for how to import data.

5.2 Setting up the SimApi for use in SIMCA-online
Important: To be able to use a SimApi, a SIMCA-online server license is required. A demo installation of SIMCA-
online does not allow SimApis to be used.

Here’s how to set up the SimApi in SIMCA-online:

1.

On the server computer, start the SIMCA-online Server Options utility from Start in Windows. Go to the
SimApi tab and click Add...

Give this instance of the SimApi a name. Use a name that distinguishes it from other data sources, such as
the server name and type (for example MyPIServer).

Click the ...-button to browse to and select the <simapi>.dll located in the installation folder.

Click OK to add the new SimApi and answer Yes to the question about launching the SimApi configuration
program.

Make the settings for the SimApi instance. Refer to the User Guide of the SimApi for information about the
available settings.

When done, close SIMCA-online Server Options and start the SIMCA-online server.
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To configure multiple instances of this SimApi, repeat the above steps and use unique names for each instance.
Read more about the different log and configuration files for the instances above.

6 Testing and troubleshooting a SimApi installation

This chapter is about testing and troubleshooting a SimApi installation.

6.1 Testing a SimApi from SIMCA-online

Once the SIMCA-online server has been started successfully you can test your SimApiin SIMCA-online (if the server
does not start, see 6.2):

Login to the serverin the SIMCA-online client, and navigate to Extract on the File tab. Extract helps you test the
SimApi by obtaining data through it:

Extract Data - Select Tags U X

j Select tags for extraction by marking nodes and adding tags

The data is extracted from SimApis connected to your data sources and is useful when troubleshooting.

i# Data sources A | | Enter filter here
—lJ EE))(mpeSi,t'-‘\i [ExampleSimApi (Sep 7 2020 15 Tags (2 of 2) Data
= an omNo f . .
g o o oo ik toviews
—+(4 OPCUA [OPC UA SIfiApi (Sep *39740)’ g
- 10 Server
- 0 DeviceSet
i L. NetworkSet A
L4 >
Il x

Selected tags (0)

There are no selected tags

e The nodes (“folders”) of the SimApi are displayed in the top-left box. Tags for the selected node are
displayed top-right.

e Current data can be tested quickly simply by clicking <Click to view> on tags that provide continuous
process data (see the screenshot)

e Right-click on a node to Find batches within a time range. The node must be a batch node that knows
about batches.

e Select tagsin Extract and click Next and finish the wizard to obtain data using the different modes of data
retrieval: current-, historical-, batch- and discrete data.

Compare the extracted data with what you see in your data source tools.
6.2 Troubleshoot SimApi problems using the SimApi log file

If the server does not start, the SimApi doesn’t work as expected or extract fails, you need to consult the SimApi log
file which tells you what the problem is. Enable Debug-level logging in the SimApi log to get full details. See 4.2.

Note: the SIMCA-online server logs* are not so useful here. They will show how the SimApi was loaded and initialized
by the server, but the SimApi specific details are in its log file.

4 Learn more on the server log at https:/umetrics.com/kb/making-use-simca-online-server-logging-finding-problems
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6.3 Use theright SIMCA-online service account

When you are testing access to the external data source, remember that you are logged in as a specific user on the
server computer (typically your own user account in a Windows domain), but that the SIMCA-online server service
account is a different account, by default LocalSystem, which has different access rights compared to your user
account.

For this reason, it is not uncommon that tests work when run as your account, but that SIMCA-online fails to connect
to the data source.

To solve this issue, access must be granted for the account that is used by the SIMCA-online server service. Typically,
you change LocalSystem to a specific domain service account, and grant rights to this account.

/ Technical details on SimApis

This chapter gives technical details on how a SimApi works. It is mainly aimed at developers that want to understand
SimApis for the purpose of implementing a SimApi for a data source.

Developers should also read the earlier parts of this document for an introduction to SimApis and to the high-level
descriptions of features.

7.1 When to consider developing a SimApi and when not to?
Before considering developing a SimApi for a data source:

1. Investigate if there already is a SimApi that you can use. Perhaps you can enable some feature in your data
source to use one of the existing SimApis, such as OPC UA.

2. Carefully go through this document and its references and investigate if your data source fulfills necessary
requirements: for example, it needs to be fast enough, provide not just current data, but also historical data
(in almost all cases).

For these reasons, we don’t recommend developing a SimApi that connects to low level hardware or instruments. It
is better to connect those instruments to a process historian such as OSlsoft Pl, and let it obtain data from the
instrument, and historize it. Then the PIAF SimApi can be used to obtain data from Pl to the Umetrics product.

7.2 SimApidevelopment and the SimApi specification

The SimApi specification, SimApi-v2, contains documentation for all C-functions in the SimApi that a SimApi DLL
needs to implement as well as some guidance for how to develop a SimApi. This implementation isa C/C++
implementation at a very low level, making directly using it as the basis of an implementation unnecessarily hard.

The recommended, and easier, way to implement a SimApi is to base it on the ExampleSimApi source code that we
provide. It is an example SimApi implementation written in .NET that handles the transition from a C interface to
.NET. It also has framework code for logging, settings, configuration GUl and other framework code, making a
SimApi implementation in .NET relatively straight forward for an experienced developer.

A SimApi can be developed by people with knowledge in .NET, C, or C++, and good knowledge of the data source
that the SimApi should connect to.u

Contact your sales representative to obtain the SimApi Software Development kit.

7.3 Reading orwriting data

A SimApi has the main task of providing data from a data source. This is referred to as reading data.

Most SimApi implementations also support writing data. This means writing back data through the SimApi to the
data source. Writing data is an optional feature in SIMCA-online.

7.4 Tagsand Nodes

Atag is an identifier of a column or “variable” in a data source. Atag’s name is used to identity the tag. Names within
node must be unique.

A node is a container of tags. A node can also contain other nodes, similarly to how a file system has folders in folders.
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Like in a file system, the node and tag names can be combined to a full path that uniquely identifies a tag. The tag
paths are used in SIMCA-online or SIMCA when selecting tags to use. A tag path starts with a SimApi instance name
followed by the node-structure, and ending with the tag name, each item separated with a colon (:). For example
“ODBCSQLServer:Node:SensorTagl”.

7.4.1 Case sensitivity of tag- and node names
Tag names and node names are case sensitive.

Thus, a tag called “tag1” is not the same as “Tagl” because of the different case of the “T”. We recommend against
using tags or node names that differ only in case.

7.4.2 Continuous process node

If a node contains tags with continuous process data, it can be referred to as a process node. The following two
screenshots show a tabular representation of a process node with data followed by a picture showing how the node
looks when selecting tags in SIMCA-online.

B Sarting_missing [Continuous Node] o || = ||
1 | 2 | 3 | s 5 6 7 A
1 Observation $BatchlD  Ethanol Temp  Molasses NH2

5484 2015-05-07 09:22:50 | gb_2015-05-07 0%:09:20 0,05726 33,134 -1433|0,09287 6704,
5424 2015-05-07 09:23:00 | gb_2015-05-07 03:03:20 0,055 33,1032 -14%4|0,11787 &704,

2015-05-07 09:23:101 hb 2015-05-07 09:23:10 0,0405 30,5541 -149% 0,08286 | 750, =
5434  2015-05-07 09:23:20 | hb_2015-05-07 09:23:10 0,0253| 30,8894 -1494 | 35,3357 | 2015,
334 2015-05-07 09:23:30 | hk_2015-05-07 09:23:10 0,09403 | 31,1833 -1497  T&,7428| 2257

5485  2015-05-07 09:23:40 | hb_2015-05-07 0%:23:10 0,256 30,8559 -1438 | 84,7357 2443,
5485  2015-05-07 09:23:50 | hb_2015-05-07 09:23:10 0,4011% 30,6198 -1499 | 85,8143 2605,
5485  2015-05-07 09:24:00 | hb_2015-05-07 0%:23:10 0,5167 30,5541 -1500| 88,3714 2730, y

Figure 3. An example of a node with data. The node name is Sorting_missing. The first column contains the time stamps of the
observations. The remaining column headers are tags. Each column contains measurements of the tags. Each row constitutes
one observation.

74 Data sources A || Enter filtter text here
—LJ DBMaker [DEMaker (Apr 22 2015 22:04:52) Tags (10 of 10 A
@
_=| Sorting_missing-BatchMode $BatchiD
Ethanal
Temp
Maolasses
NH3
Air
Level
] pH
< > T W

Figure 4: This is how the same node looks from SIMCA-online. You see the node name to the left, and the tags in that
node listed to the right. The full tag path to the Ethanol tag in this screenshot is :DBMaker:Sorting_missing:Ethanol.

7.4.3 Continuous process nodes must be independent of batches, runs or time

To work well in a SimApi a node must be independent of batches, runs, or time. Having a node that contains data for
a specific batch or time range would not work well in SIMCA-online because the project configuration then could
only read data for that batch and not be used for other batches.

Instead, a node should be mapped to one or more physical units in the process where measurements are performed.
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7.4.4 Batch node

Abatch node is a node that keeps track of batches; their batch identifiers, start times, and end times. Itis a
requirement for batch project execution in SIMCA-online. If you don’t have a batch node in your data source, you
can use the Batch Context Generator in SIMCA-online. See the built-in help.

A batch node can also contain batch data; data for which there is only one observation for the whole batch. Note
that tags with batch data need not be in a node that has the full functionality of a batch node. It is enough that the
SimApi supports reading batch data for the tags. Learn more on batch data in 7.6.

Here is an example of a batch node:

== Sorting_missing-BatchMode [Batch Node] E@
1 E 3 | 4 [s [ [ 7 [ 8 [ 9o | ~
1 Observation H Start Time Stop Time QP1 QP2 Innoc Amount Yield

667 | Ta_2015-05-07 06:51:00 | T 2015-05-07 06:51:00(1430974260)  2015-05-07
668 | Va_2015-05-07 07:04:50 ¥ 2015-05-07 07:04:50(1430975090) | 2015-05-07
669 | Xa_2015-05-07 07:18:40 X 2015-05-07 07:18:40(1430975%20) | 2015-05-07
670 | Za_2015-05-07 07:32:30 | Z 2015-05-07 07:32:30(1430976750) | 2015-05-07
671 | ab_2015-05-07 07:46:20 =z 2015-05-07 07:46:20(1430977580) | 2015-05-07
672 | bb_2015-05-07 08:00:10 k 2015-05-07 08:00:10(1430978410) | 2015-05-07

c

d

e

a

T:04:40(14309735080) c
T:18:30(1430975910)
132:20(1430976740)
:46:10(1430977570)
:00:00({1430978400)
:13:50(1430979230)

6960 0,505663

o

[¥]

993, 28 6597 0,504218
952,32 5541 0,45427
947 5745 0,492269
914 5365 0,482205
452 5875 0,500618
452 5835 0,505364
452 5973 0,4818
960 5402 0,46254
450 5982 0,47437
943 5977 0,470986

o

=]

=]
[ R R R

=

w

7
673 | cb_2015-05-07 08:14:00 | c 2015-05-07 08:14:00(1430979240) | 2015-05-07 08:27:40(1430980060)
674 | db_2015-05-07 08:27:50 |d 2015-05-07 08:27:50(1430980070) | 2015-05-07 08:41:30(1430980830)

s

673 | eb_2015-05-07 08:41:40 | e 2015-05-07 08:41:40(1430980900) | 2015-05-07 08:55:20(1430981720)
676 | fb_2015-05-07 08:55:30 | £ 2015-05-07 08:55:30(1430981730) | 2015-05-07 09:09:10(1430982550)
677 | gb_2015-05-07 09:09:20 | g 2015-05-07 09:09:20(1430982560) | 2015-05-07 09:23:00(1430983380)

678 hh_2015-05-0709:23:10|h 2015-05-07 09:23:10(14309833590) | 2015-05-07 15:28:23(1431005303)

oo

wh

L I R T R At
s =P S =P S = P« S = PR - = TR - =

(]
o

v

Figure 5. A sample batch node named Sorting_missing-BatchNode. The first column contains batch identifiers, followed by the
start time and end time of the batch. The last five columns are tags with batch data (batch conditions). This example also shows
the different data types which are defined in 7.5: QP1and QP2 are qualitative (text) tags the remaining tags contain numerical
data. Also notice the missing data highlighted in yellow in some cells.

Note: The above screenshot is taken from DBMaker, bundled with SIMCA-online. To see this yourself in DBMaker,
click the View Data button on the Bakers Yeast database to display two windows, one of which is the batch node,
and the other the process data.

7.5 Data types: numerical data, text data and missing data
For each tag, a SimApi can support three types of data: numerical, text and missing:

o Numerical data are typically real values of process parameters, for example 6.5. The SimApi interface as
currently defined can only handle 32-bit floating point values. All other numerical data types in a data
source should be converted to float.

e Text/string data are used for batch IDs, phase execution conditions or for qualitative variables. The values
for text tag data are case sensitive. This means that the value “running” is not the same as “RUNNING”.
Datetime variables are not supported directly by the SimApi, but they can be returned as a string formatted
as YY-MM-DD HH:MM (for example “2020-09-07 13:45").

e Missing values means there is no value to return, i.e. no data.

What type is returned by a SimApi is up to the SimApiimplementation. A SimApi knows about the data in the data
source and should return the data type that fits best.

7.6 Three modes of data retrieval: Continuous, Batch and Discrete
The SimApi specification defines three modes of retrieval for data, i.e. three different ways the SimApi can provide
data from tags in a data source (or in the other direction: write data to tags in a data source).

Continuous data retrieval - this refers to data read continuously, and sequentially, observation per observation as
the batch or process evolves. Data is read for a specific time, or range, at a regular interval between observations.

Batch data retrieval - this refers to a single observation with data for an entire batch (not associated with a specific
maturity or time point). Batch attributes and local centering data are read as batch data in SIMCA-online. Batch
conditions are normally read as batch data too (unless they are configured for discrete data retrieval).

Discrete data retrieval - discrete data can consist of several observations for many maturities. But unlike continuous
data, discrete data is not read sequentially but rather all data at once for a specific phase of a batch. Data need not
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be spaced with regular intervals of the maturity variable. All data is re-read each time the data is requested, at the
configured interval.

For any given tag data can be requested in any of the three modes, but typically a SimApi will only support one of
these modes for an individual tag. Likewise, it is theoretically allowed to mix tags within a node, but typically all tags
within a specific node support the same mode of data retrieval.

For continuous data (but not for batch- or discrete data®), requests can be made for current data or historical data
which is the topic of the next section.

Not all SimApis support all modes. See the feature matrix above and the SimApi web page for details.

7.7 Current and Historical continuous data through a SimApi

7.71 Current data

Reading current data means asking the data source for values of one or more tags at the time of asking. Notice that
the time of the external data source is not used here. The SimApi reports the latest values from the data source to
the SIMCA-online server.

The data read as current data is what SIMCA-online will show as live data. For this reason, it is important that there
are no unnecessary delays in the data source. Current data should be as recent as possible to work well in SIMCA-
online.

/.7.2 Historical data

Reading historical data means asking the data source for values of one or more tags for a specific time range with a
specific interval between observations. Notice that here it is the external data source’s local time that is used to find
the data. Therefore, time synchronization between data source and servers are important.

Historical data consists of a matrix of data. It is up to the SimApi implementation to request the data from the data
source, and sample it at the specified interval and construct the matrix of data to return:

e Sometimes the data source itself has aggregation functions to return processed data, or sampling functions,
that can be used to return the right data.

e Forother data sources the SimApi has to request all data in the time range (typically also requesting the
observation before the start of the time range to be able to know the initial value), and then manually
sample the right observations.

Note: SIMCA-online typically does not request more than hundreds of observations in one call during normal
project execution. When doing extract in SIMCA-online, or when running SIMCA, larger requests of data can be
made. These can take a long time which is perfectly normal.

7.7.3 Current data and historical data must match

Sometimes there can be differences when data is read as real-time current data or historical data. This causes
problems in SIMCA-online because the server automatically switches between current and historical data as
needed.

Read more relating to time differences across the system, and interpolation and compression in the data source in
the SIMCA-online Technical Guide.

/.7.4 More real-time requirements
Read more on requirements for real-time data sources in the SIMCA-online Implementation Guide in the section
about Data Requirements.

7.8 Datacan be read foranytimeT
When SIMCA-online asks for a value of a tag for time T it will receive the value from the data source from time T, or
the latest observation in the data source before time T, or an interpolated value for time T. Thus, the server will always

5 As you saw above, all discrete data is read each time data is requested, and thus it doesn’t make sense talking about
current or historical data here.
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get a value at each time it asks for, even though and observation for this exact time point might not exist in the data
source.

Timestamps in the SimApi are always UTC.
SIMCA-online clients and SIMCA present the time as local time.
7.9 Threading

The SimApi is called by a single thread by the user of the SimApi. Thus, the SimApi need not worry about multi-
threading.

7.10 Error handling

When a SimApi cannot fulfill a request from the data source it can handle this problem in one of two ways; by
returning missing values (no data) or by signaling a SimApi error:

1. Returning missing values to the caller and signaling success allows the caller to continue as normal (but of
course without any data). This is a recommended practice for partial errors such as when data for could be
obtained for some, but not all, tags in a request.

2. Signaling a SimApi error allows the caller (for example the SIMCA-online server) to see this immediately and
to act. This is a recommended practice for requests that fails completely and cannot return any data at all.

SIMCA-online handles missing values or error codes differently, as is described in the SIMCA-online Technical
Guide.
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